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Copyright Notice and Proprietary Information 
All rights reserved. 

© Attix5, 2011 

Trademarks 

® - Mac, Tiger, Leopard and Snow Leopard are registered trademarks of Apple Inc. 

 
 

Instruction Symbols 
The following icons are used in this user manual: 

 

 The information icon precedes important information. 
 

 The example icon indicates a practical illustration of a process or procedure. 
 

 The hint icon indicates a suggestion or hint to guide or assist you with performing a task. 
 

 The warning icon provides a warning against potential mistakes and actions that could 
cause critical error. 
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Introduction 
Congratulations on choosing Attix5 Pro Desktop & Laptop Edition. Attix5 Pro minimises risk, 

maximises productivity and allows businesses to regain control of their most valuable asset - 

their data. 

 

For technical support, please go to Attix5 Pro > About Attix5 Pro, and then use the contact 

details provided. 

Product overview 
With Attix5 Pro Desktop & Laptop Edition (DL), data stored on desktop and laptop computers 

can be backed up to a Storage Platform quickly, securely and automatically. 

 

The following diagram illustrates the scenario: 

 

 

Files and folders stored on desktop or laptop 

computers running Attix5 Pro DL can be 

backed up to a Storage Platform. In the event 

of data loss or corruption, you can retrieve 

data from the Storage Platform and restore it 

to the original or another computer in just a 

few easy steps. 

 

 

 

 

A Backup Administrator can manage the entire backup environment (DL Clients and the 

Storage Platform) remotely, using the Attix5 Pro Storage Platform Console. For more 

information, please refer to the Attix5 Pro Storage Platform Console User Manual. 

 

DL 

DL 

Storage Platform 
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Install DL 
(See page 9)

Create a Backup 
Account 

(See page 14)

Select files and 
folders for 

backup
(See page 29)

BACK UP
Automatically or 

manually
(See pages 39- 41)

1 Getting started 
Enabling manual or automatic backups is easy with Attix5 Pro Desktop & Laptop Edition: 
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2 Installation 
Below are the system requirements for Attix5 Pro Desktop & Laptop Edition. 

 Note: For the latest system requirements and compatibility information, please refer to 
the Requirements-Compatibility.pdf (provided with each release of the Attix5 Pro 
software). 

System requirements 

Operating System  

DL is available for the following Macintosh operating systems: 

• MAC OS X 10.4 (Tiger) 

• MAC OS X 10.5 (Leopard) 

• MAC OS X 10.6 (Snow Leopard) 

Processor & Memory 

• Required: PowerPC G3, G4 or G5/Intel Core processor with 128 MB memory above 

operating system requirements. 

• Recommended: 256 MB above operating system requirements. 

 

Disk Space  

• Required: 50 MB plus space for local cache. 

 Note: Please ensure that the drive on which the Backup Client will be installed has 
enough free space to store copies of the selected files.  

 

• Recommended: Amount of free space equal to the Backup Account limit. The local 

cache can be as large as the total size of all files included in the backup selection.   

 Example: A file inclusion of 100 MB needs up to 100 MB extra disk space for the 
cache. 

 

Other 

• Minimum video requirements: 800 x 600 Resolution, 256 colours 
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Installing Attix5 Pro DL 

The DL DMG file contains pre-configured information to make installing DL quick and easy.  

 Note: The options available during the installation process depend on the settings 
enabled by the administrator when the DMG file was created. These options range from 
advanced install settings to specifying the install location.  

 Pre-installation warnings:  
If running antivirus software, please ensure that all Attix5 Pro folders are excluded from 
being scanned to avoid data corruption. 
Both antivirus software scans and backup processes are resource-intensive. It is 
advised not to run a backup and virus scan at the same time as this will significantly 
decrease machine performance. 
Please ensure that you run the DMG file suited to the installed operating system (i.e. 32-
bit or 64-bit). The filename should indicate the target platform. If unsure, please contact 
your Backup Administrator. 

To install Attix5 Pro DL: 

• Run the DMG file. 

• Run the PKG file. 

• In the Attix5 Pro Installer that appears, follow the steps to completion. See below. 

 

Attix5 Pro Installer 

The Attix5 Pro Installer typically consists of four steps to guide you through the installation in a 

simple, step-by-step manner. These steps also make it possible to undo previous operations by 

navigating backward. 

 

 Note: Some of the settings encountered in the installer may have been removed when 
the DMG was created. Furthermore, the installer may contain additional steps. Please 
read each window carefully before continuing. 
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Step 1 of 4:  Welcome 

The Welcome page will outline the task to be performed. 

To start the installer:  

Click Continue.
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Step 2 of 4:  Select an install destination 

To select a destination for the DL application files and folders: 

• Select the disk on which you wish to install DL. 

• Click Continue. 
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Step 3 of 4:  Install  

To begin the DL installation:  

Click Install. 

 

 Tip: Should you wish to change the install location, you can use the Change Install 
Location button.  

 Note: At this point, you may be prompted to provide a password to allow the installer to 
make the required changes to the operating system. Supply your Mac username and 
password in the boxes provided, and then click OK. 
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Step 4 of 4:  Close the installer 

To close the installer:   

Click Close.  

 

After clicking Close, Attix5 Pro DL will be installed on the machine.  

 

Upon opening the DL Client for the first time, the Backup Account Setup Wizard will launch, 

enabling you to create a Backup Account. Follow the wizard steps as described in Chapter 3, 

“Account setup.” 
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3 Account setup 
To be able to back up or restore data using the Backup Client, a Backup Account is required. 

 

Setting up a Backup Account 

The Account Setup Wizard will launch when the Backup Client is opened for the first time (for 

more information, see Opening the Backup Client in Chapter 4, “Graphical User Interface”).  

 

 Note: To run the Account Setup Wizard at any other time: On the Tools menu, click 
Account Setup Wizard. In the warning box that appears, click the Run Account Setup 
Wizard button and follow the instructions below from Step 2 onwards. 

 

Account Setup Wizard 

The Account Setup Wizard typically consists of seven steps to guide you through the Setup task 

in a simple, step-by-step manner. These steps also make it possible to undo previous 

operations by navigating backward.  

  

 Note: Some of the settings encountered in the wizard may have been removed when the 
Installation DMG was created.  Furthermore, the wizard may contain additional steps. 
Please read each window carefully before continuing. 
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Step 1 of 7:  Specify Storage Platform connection settings 

 

 Note: This step displays when the wizard is run directly after the DL Client installation. If 
accessing the wizard at a later stage (via the Tools menu), this step will not display as 
the Storage Platform settings will already have been configured. 

To specify the Storage Platform connection settings: 

• In the Storage Platform address box, type the IP address or DNS name of the Storage 

Platform where the Backup Account resides.   

• In the Group name field, specify which Backup Group the Account belongs to. 

• In the Group create key field, specify the preconfigured Group create key for the 

applicable Group. If you do not have access to this key, please contact your Storage 

Platform administrator. 

 

Note: This key is case sensitive. 
• Once all the correct settings have been entered, click Next. 
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Step 2 of 7:  Create or connect to a Backup Account 

 Notes:  
This wizard step is typically the first to be displayed if you access the wizard via the 
Tools menu. 
You can select I want to connect to an existing Backup Account to: 

Connect to an Account that has been opened for use by this computer. 

Reconnect to an Account to recover data from the computer that had previously 

backed up to this Account. 

To create a new Backup Account:  

• Select I want to create a new Backup Account. 

• Click Next. 

To connect to an existing account: 

• Select I want to connect to an existing Backup Account.  

 Warning: Different users cannot back up to the same Backup Account.  
A separate Backup Account needs to be created for each user. 

• Click Next to continue. 
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Step 3 of 7:  Specify Account details 

When connecting to an existing Account:  

• In the Backup Account name box, type the Account name. 

• In the Account password box, type the Backup Account password. 

• In the Encryption key box, type the encryption key chosen when the Backup Account 

was created. 
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To specify the new Account details: 

1. In the Backup Account name 

box, type an Account name that 

consists of a minimum of 4 

characters. 

2. In the Account password box, type a password that consists of a minimum of 4 

characters. 

3. In the Confirm password box, repeat the Account password entered in the Account 
password box above. 

4. In the Encryption key box, type an encryption key that consists of a minimum of 8 

characters. 

5. Click Next. 

 

 Warning: Disaster recovery is not possible without the encryption key. Please ensure that 
this key is kept in a safe place. THE ENCRYPTION KEY IS NOT STORED ON THE 
STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF LOST. 
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Step 4 of 7:  Specify connection settings 

To specify the connection settings:  

• In the Connection Settings area, select I use broadband or another permanent 
network connection. 

• Click the Configure Proxy button. 

• In the Proxy Setup dialog box that appears, select a proxy type. 

• If Use SOCKSv5 Proxy or Use HTTP Proxy is selected, fill in the Proxy Host and 

Proxy Port boxes. 

• If login details are required, select the Proxy server requires authentication check 

box and type the username and password in the boxes provided. 

• Click OK to close the Proxy Setup dialog box. 

• Click Next to move to the next step in the wizard.   
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Step 5 of 7:  Schedule backup process 

Attix5 Pro can run backups on included files and folders either upon request (manually) or 

automatically. This step enables you to set up a backup schedule.  

 Tip: It is advised to back up at night when the machine is running and the Backup Client is 
not in use. The machine must be switched on at the time(s) specified for scheduled 
backups, but the Mac  user does not need to be logged in. 

To configure the Backup Client to run only manual backups:  

• Clear the Daily automatic backups check box. 

• Click Next to move to the next step in the wizard. 

 Warning: This option is not recommended. If an automated backup schedule is not 
created, backups will have to be run manually. Enabling automatic backups is strongly 
advised. 

To schedule daily automatic backups: 

• Select the Daily automatic backups check box. 

• In the Back up every day at box, specify a backup time. 

• Click Next to move to the next step in the wizard or schedule additional advanced 

backups as described below. 
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To schedule advanced backups: 

• Select the Advanced Schedule check box. 

• In the Week Day area, select a day on which a backup should be initiated. 

• Specify the time in the Backup time box. 

• Click the Add button to add the day and time to the Additional Schedule box. 

• Repeat the steps above until you have added all desired schedules to the Additional 
Schedule box. 

• Click Next to move to the next step in the wizard. 
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Step 6 of 7: Specify working folder locations 

 

Under normal circumstances, the default Temp, Cache, Logs and Database folder locations 

can be accepted and you can click Next without making any modifications. If, however, the drive 

on which the Backup Client is installed has limited space available, you can move the folders 

and selection database to another location. 

 Warning: Please ensure that these folders are located on a drive with sufficient free 
space. 

To change the temp, cache, logs and/or database folder locations: 

• Click the Browse button next to the appropriate box (e.g. Temp), and then select a 

different location for that folder. 

• Repeat step 1 above until all folder locations are correctly specified. 

• Click Next to continue with the installation process. 

 

 Warning: The Cache and Temp folders must reside on the same drive/volume. 
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Step 7 of 7:  Confirm configuration and exit the wizard 

In the final step of the Account Setup Wizard, a Summary screen displays a list of the 

configured settings.  

To confirm the Setup information: 

• Read and verify that the information is correct, and then click Next. 

• The Backup Client will connect to the Storage Platform and configure the Backup 

Account.  A message will be displayed to confirm that the Account was set up 

successfully.  

• Click OK to close the message box. 

Now that a Backup Account has been configured/you have connected to an Account on the 

Storage Platform, you can select the files and folders you wish to back up. 
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4 Graphical User Interface (GUI) 
You can use the Graphical User Interface (GUI) to:  

• Select files for backup 

• Launch backups 

• Schedule automatic backups  

• Find files in previous backups 

• Restore files and folders from previous backups 

Opening the Backup Client interface 

To open the DL Client interface: 

Click the Attix5 Pro icon in the Dock. 

 

 Note: The first time you open the Backup Client, the Account Setup Wizard launches 
automatically. For more information on creating a Backup Account, see Chapter 3, “Account 
setup.” 

 

The Client interface explained 

You can manage and monitor backups using the Backup Client application window.  

Application window 

The Backup Client application window contains the following areas: 

 
Menu bar 

Toolbar 

Tabs 

Product Help 

Status bar 
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Menu bar and toolbar buttons 

All Backup Client functions can be performed from the menu bar. Shortcuts to the most 

commonly used menu bar functions are also available on the toolbar and shortcut (Control-click) 

menus. 

Menu bar 

Each menu on the menu bar contains one or more options. The tables below describe the  

Attix5 Pro options available.  

 

Attix5 Pro menu  

Option Click the option to... 

About Attix5 Pro Access the product information and support contact details. 

Preferences 

Opens the Options and Settings dialog box that enables you to modify a range 

of Client settings. For more information, see Chapter 8, “Options and 

Settings.” 

Hide Attix5 Pro 

Hides the Attix5 Pro application window. 

 Note: This will not stop the Attix5 Pro service from running 

scheduled backups.  
 

Quit Attix5 Pro Closes the Attix5 Pro application. 

 

File menu   

Option Click the option to... 

Backup Now Initiate a Backup immediately. 

Restore 

Switch to the Restore view in the Client.  

 Tip: For faster access to the Restore view, click the Restore 

tab instead of using the File menu. 
  

Calculate Size 

Determine the total size of the data included in the backup selection. For more 

information, see Determining the backup selection size in Chapter 5, 

“Backups.” 
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File menu continued...  

Option Click the option to... 

Find Files in Backups 

Access the Find Files in Backups dialog box. This box enables you to search 

for particular files in your backups. For more information, see Finding files in 

backups in Chapter 6, “Restores.” 

Export Selection 

Export a list of all backup inclusions and exclusions to an html file for future 

reference. For more information, see Exporting a selection report in Chapter 5, 

“Backups.” 

 

Tools menu   

Option Click the option to... 

Automatic Backups 

Access the Backup Schedule settings in the Options and Settings dialog box. 

Configure the settings in the Automatic Backups area to set up one or more 

automatic backups. For more information, see Scheduling automatic backups 

in Chapter 5, “Backups.” 

Account Setup Wizard 

Launch the Account Setup Wizard, which enables you to change the Backup 

Account settings. For more information, see Account Setup Wizard in Chapter 

3, “Account setup.” 

Remote Management 

Access the Remote Management Settings dialog box. Using the settings 

available, you can enable Remote Management of the Client via the SP 

Console. For more information, see Remote Management in Chapter 8, 

“Options and Settings.” 

Health Check 

Access the Health Check dialog box. Performing a Health Check enables you 

to highlight possible issues. For more information, see Health Check in 

Chapter 8, “Options and Settings.”  

Snapshot > Export 

Backup Snapshot 

Access the Export Backup Snapshot dialog box, which enables you to 

configure the next backup to be a Snapshot backup to a specific location. For 

more information, see Backup Snapshots in Chapter 8, “Options and Settings.” 

Option Click the option to... 

Snapshot > Import 

Restore Snapshot 

Access the Import Backup Snapshot dialog box, which enables you to 

configure Restore Snapshot settings. For more information, see Restore 

Snapshots in Chapter 8, “Options and Settings.” 
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View menu 

Option Click the option to... 

Language > 

[English/German/Defau

lt] 

Access the GUI language options available.  

 

Help menu 

Option Click the option to... 

Icon Legend 
Access a list of the icons used in the Attix5 Pro Client and the statuses they 

indicate.  

Product Help Access the Product Help. 

 

Tabs 

 

There are three tabs available in the Backup Client:  

• Backup Selection:  This tab displays the files and folders on the computer, enabling 

you to select the items to be backed up. For more information, see Selecting data to 

back up in Chapter 5, “Backups.” 

• Restore:  Use this tab to browse previous backups and restore files and folders. 

• Logs:  Use this tab to view detailed information on each backup and restore. 

 

 Tip: When the Backup Selection and Restore tabs are selected, you can click any of 
the column headings in the right-hand pane to sort the contents accordingly. 
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Product Help 

 

You can access the Backup Client Help by clicking Product Help on the Help menu. 

Alternatively, click the Help button on the toolbar. 

As you navigate the Client, the Help pane will display information relevant to the selected tab. 

 

Status bar 

This area displays the date and time of the last backup performed by the system. 
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5 Backups 
After installing Attix5 Pro Desktop & Laptop Edition (DL) and creating a Backup Account, you 

can tell the Backup Client which files and/or folders to back up and which to ignore by creating a 

backup selection (see “Selecting data to back up” below). You can then start a backup manually 

or schedule automatic backups (see “Performing a manual backup” and “Scheduling automatic 

backups” below). 

 Note: Any changes, additions or deletions to included files and folders will be backed up 
intelligently with every manual or scheduled backup. 

 

How to back up 

The following sections describe how to: 

• Select data to back up 

• Use filters to specify files and/or folders to be excluded from the backup selection. 

• Determine the backup selection size 

• Start backups (automatically and manually) 

• Cancel a backup 

• Resume a failed or cancelled backup 

 

Selecting data to back up 

You can make your first backup selection or modify a backup selection at any time using the 

Backup Selection tab as described below. 

To select files and folders for backup: 

• Click the Backup Selection tab.   

• In the Backup Selection tree, navigate to the folder or directory containing the file or 

folder.  

• Include or exclude files and/or folders, as described below. 

 

 Tip: Once a file or folder is included in the backup selection, any modifications to it will be 
backed up automatically. 

 Warning: If you have limited space on the drive running the Backup Client, it is 
recommended that you move the Cache, Logs and Temporary folders as well as the 
selection database to another location. For more information, see Disk Usage in  
Chapter 8, “Options and Settings.” 
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To include an individual file: 

In the Backup Selection tree, navigate to the folder or directory containing the file. In the right-

hand pane, click the file icon ( ) or point to the file name and Control-click, and then 

click Include. An included file is displayed with a green icon: . 

 

To deselect a file, you can either click the icon again or point to the file name and Control-

click, and then click Deselect. A folder containing some included files is displayed with a green 

tinted icon: . 

To include an entire folder: 

Point to the folder icon ( ) and Control-click, and then click Include Folder. Alternatively, you 

can select the folder in the Backup Selection tree, and then click Include Folder on 

the Selection menu. Included folders are displayed with a green icon: . 

 

 Note: All files in the included folder and its subfolders will be included in the next backup. 
Any changes made within this folder or its subfolders will automatically be included as 
well. 

To deselect a folder: 

Point to the folder icon, Control-click, and then click Deselect Folder. 

To exclude a file or subfolder: 

If an entire folder is included but you wish to exclude a particular file or subfolder, point to the 

file or folder icon and Control-click, and then click Exclude or Exclude Folder. Excluded items 

are displayed with red icons:  or . Folders that have been included but have some files or 

subfolders excluded are green with a red tint: . 

  

 Tips:  
You can use filters to automate file selection based on file types.  
Once you have selected all files to be included and excluded, it may be useful to check 
the size of your backup selection before initiating your first backup. For more 
information, see Using Filters later in this chapter. 

 Note: Some directories (and their contents) are forcefully excluded from the backup 
selection. On Mac machines, these are the /dev and /proc directories. 

  



 

 

 

 

Zen Internet, Sandbrook Park, Sandbrook Way, Rochdale OL11 1RY    Registered in England No. 03101568 
Tel: 01706 902000  Fax: 01706 902005  Email: info@zen.co.uk  Web: www.zen.co.uk © Zen Internet 2015 

 

29 

Using filters 

You can use filters to automate file inclusions or exclusions within a folder, based on file types. 

 

 Example: A *.pdf filter will include or exclude all PDF files within a folder, as well as any 
new PDF files that are added to that folder later. 

To apply a predefined filter to a specific folder: 

• In the Backup Selection tree, point to the folder icon and Control -click. 

• Point to Filters. 

• Point to one of the available filters in the list (e.g. MS Office documents). 

• Click Include or Exclude. 

To modify an existing filter: 

• In the Backup Selection tree, point to the folder icon and Control-click, point to Filters, 

and then click Edit filters. 

• Select one of the filters and then modify its properties in the Edit filter box. 

• Click OK. 

 

 Tip: To add a new filter from within the Edit filters dialog box, click the New button, 
supply a name that describes the filter, enter the file type(s), and then click OK. 

To add a new filter via the Backup Selection tree: 

• Point to the folder icon, Control-click, and then click New filter. 

• In the Filter name box, type a name to be used in the Filters menu. 

• In the Filter box, specify the file extensions to which the filter will apply. 

• Click OK. 

 

The filter will be added to the Filters menu and you will be able to use it to include or exclude all 

files matching its criteria. 

To remove filters from a folder: 

• Point to the folder icon and Control-click. 

• Point to Filters. 

• Point to the name of the filter you wish to remove. 

• Clear the check mark next to the selection (Include or Exclude). 
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To identify files and folders selected by filters: 

Look at the icon state. Files and folders included in the backup selection by filters display with 

icons containing blue check marks:  and . 

 

Profiled inclusions and exclusions 

Some inclusions and exclusions are enforced at administration level on the Storage Platform. 

This is called “profiling”. For more information, see Profiling in Chapter 8, “Options and 

Settings.” 

 

Files and folders affected by profiling display with the following icons: 

 

Icon Status 

 File inclusion 

 Filtered file inclusion 

 File exclusion 

 Folder inclusion 

 Filtered folder inclusion 

 Folder exclusion 

 

 Note: Profiled selections cannot be modified from within the Backup Client and can only be 
changed on the Storage Platform. For more information, please refer to the Attix5 Pro Storage 
Platform Console User Manual. 
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Icon legend 

On the Backup Selection tab, each file and folder is displayed with an associated icon. The 

colour of the icon indicates the file or folder’s backup selection status. (For more information on 

backup selections, see “Selecting data to back up” earlier in this chapter.) 

 
The following icon legend lists the Attix5 Pro icons and the statuses they indicate. You can 

access this legend by clicking Icon Legend on the Help menu. 

 

 Note: For more information, see Profiled selections in Chapter 4, “Graphical User Interface 
(GUI)” and Plug-ins in Chapter 9, “Plug-ins.” 

 

Icon legend   

Icon Status Description 

 File (not selected) 
The file exists in the folder or directory but is not included in the 

backup selection (neither included nor excluded). 

 Selected by user The Backup Client user has included the file in the backup selection.  

 Selected by user filter 
The Backup Client user has applied a filter to the parent folder or 

directory. That filter has included the file in the backup selection. 

 Excluded by user 
The Backup Client user has excluded the file from being backed up to 

the Storage Platform. 

 
Excluded by 

administrator 

The Backup or Storage Platform Administrator has excluded this file 

or its file type. Files displaying this icon will not be backed up to the 

Storage Platform. 

 Included by profiling 

The Backup or Storage Platform Administrator has included this file 

or file type. Files displaying this icon will be backed up to the Storage 

Platform and cannot be deselected from within the Backup Client. 
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Icon legend continued... 

Icon Status Description 

 
Included by profiling 

filter 

The Backup or Storage Platform Administrator has applied a filter to 

the parent folder or directory. That filter has included the file in the 

backup selection. Files displaying this icon cannot be deselected or 

excluded from within the Backup Client. 

 Included by profiling 

The Backup or Storage Platform Administrator has included this file 

or file type. Files displaying this icon will be backed up to the Storage 

Platform and cannot be deselected from within the Backup Client. 

 
Included by profiling 

filter 

The Backup or Storage Platform Administrator has applied a filter to 

the parent folder or directory. That filter has included the file in the 

backup selection. Files displaying this icon cannot be deselected or 

excluded from within the Backup Client. 

 Excluded by profiling  

The Backup or Storage Platform Administrator has excluded this file 

or its file type. Files displaying this icon will not be backed up to the 

Storage Platform and cannot be included in the backup selection from 

within the Backup Client. 

 Folder (not selected) 
The folder exists in the directory but it is not included in the backup 

selection. 

 
Some files selected by 

user 

The Backup Client user has included some files in the backup 

selection. 

 All files selected by user The Backup Client user has included all files in the backup selection. 

 
All files selected by 

user, some excluded 

The folder contains no unselected files. Each file is either included or 

excluded. 

 
All files excluded by the 

user 

The Backup Client user has excluded all files in the folder from being 

backed up to the Storage Platform. 

 Filter applied by user 
The Backup Client user has applied a filter to the folder. The filter has 

included one or more files within the folder. 

 
Filter applied by user, 

some excluded 

The Backup Client user has applied a filter to the folder that has 

included and excluded files within it. 
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Icon legend continued... 

Icon Status Description 

 
All files included by 

profiling 

The Backup Administrator has included all the files contained in 

the folder. All files will be backed up to the Storage Platform. 

These inclusions cannot be changed by the Backup Client user. 

 Filter applied by profiling 
The Backup Administrator has applied a filter to the folder. This 

filter cannot be removed by a Backup Client user. 

 
Filter applied by profiling, 

all items excluded 

The Backup Administrator has applied a filter to the folder, 

resulting in the folder being excluded from the backup selection. 

This filter cannot be removed by a Backup Client user. 

 

Filter applied by profiling, 

some items included by 

user 

The Backup Administrator has applied a filter to this folder using 

profiling and some items have been manually included by the 

Backup Client user (see “Selecting data to back up” earlier in this 

chapter). 

 

Filter applied by profiling, 

some items included and 

some items excluded by 

user. 

The Backup Administrator has applied a filter to this folder using 

profiling. Some items have been excluded and others included 

by the Backup Client user (see “Selecting data to back up” 

earlier in this chapter). 

 

Filter applied by profiling 

but items excluded by 

user. 

Items in the folder have been included using filters (see “Using 

filters” earlier in this chapter.) 

 
Folder excluded by Global 

Filter. 

The folder has been excluded using Global Filters. For more 

information, see Global Filters in Chapter 8, “Options and 

settings.” 

 
All files excluded by 

profiling 

The Backup Administrator has excluded all files in the folder. 

These excluded files cannot be included by a Backup Client 

user.  

 
Plug-in node (not 

selected) 

The plug-in exists but is not selected for backup to the Storage 

Platform. 

 
Some items selected by 

user 

The Backup Client user has selected some of the items in the 

plug-in for backup to the Storage Platform. 

 All items selected by user 
The Backup Client user has selected all items in the plug-in for 

backup to the Storage Platform. 
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Icon legend continued... 

Icon Status Description 

 
All items selected by user, 

some excluded 

The Backup Client user has included and excluded items in the 

plug-in. 

 All items excluded by user 
The Backup Client user has excluded all items in the plug-in 

from being backed up to the Storage Platform. 

 Filter applied by user 

The Backup Client user has applied a filter to the plug-in; 

specifying that certain file types must be included for backup to 

the Storage Platform. 

 
Filter applied by user, 

some excluded 

The Backup Client user has applied a filter to the plug-in; 

specifying that certain file types be included for backup to the 

Storage Platform but some items have been excluded either 

through the use of an exclusion filter or by manual exclusion. 
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Determining the backup selection size 

It is useful to determine the backup selection size before starting the backup process to avoid 

Over Limit errors. 

 

 Note: The Backup Client compares your backup selection size with the Backup Account 
limit (specified by your Backup Administrator) at the beginning of the backup process. If 
the selection size exceeds the Account limit, the backup process will stop and an Over 
Limit error message will be displayed. 

To calculate the backup selection size:  

• On the File menu, click Calculate Size.  

• Alternatively, click the Size button on the toolbar: 

 
The Backup Selection Size dialog box that appears displays total size of your backup selection 

(i.e. all files included for backup). 

 

 Warning: If your backup selection size exceeds your Account limit, you need to remove 
some items from the selection or ask your Backup Administrator to upgrade your Account 
limit. 

To remove a file from the backup selection: 

• In the Size dialog box, point to file’s icon:  and Control-click. The icon will turn red to 

indicate that it is excluded: .  

 Note: To exclude multiple files at once, click a file name in the list, hold down the 
Shift key and drag the mouse pointer to highlight the files. Place the mouse 
pointer over the selection, Control-click, and then click Exclude. 

• Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are 

currently selected for backup. For more information, see Selecting data to back up in 

Chapter 5, “Backups.” 



 

 

 

 

Zen Internet, Sandbrook Park, Sandbrook Way, Rochdale OL11 1RY    Registered in England No. 03101568 
Tel: 01706 902000  Fax: 01706 902005  Email: info@zen.co.uk  Web: www.zen.co.uk © Zen Internet 2015 

 

36 

Exporting a selection report 

After creating a backup selection, you can export a list of all backup inclusions and exclusions to 

an html file for future reference. 

 

The selection report will specify: 

• Files and folders included in the backup 

• Files and folders excluded from the backup 

• How each item was selected (user-selected, filters, profiling or mandatory patching) 

• Where each item is located on the machine 

• The total number of items in the backup selection 

To export a selection report: 

• On the File menu, click Export Selection. 

• In the Save As dialog box, select the location in which to save the file, type a file name 

in the File name box, and then click Export. 

 

The file will be saved to the specified location and can be viewed in any Internet browser. 
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Starting a backup manually 

 Tip: It is recommended that you run a backup manually after creating your backup selection to 
ensure immediate data transmission to the Storage Platform. Thereafter, automatic backups will 
ensure hassle-free continuous backups. For more information, see “Scheduling automatic 
backups” later in this chapter. 

To start a backup manually: 

• On the File menu, click Backup Now. Alternatively, click the Backup button on the 

toolbar. 

 

Backup 

The Backup dialog box appears and displays the progress of the backup: 

 
1. To close the Backup Client after the backup process has started, click the Hide button.  

This will not cancel the backup process and the Backup Client can be re-opened at any 

time to view the progress of the backup. 

 

 Tip: To view backup logs, click the Logs tab. Backup log dates are displayed in blue. 
 

Scheduling automatic backups 

Automatic backups are usually enabled and configured during the Account Setup process (see 

Step 5 of 7: Schedule Backup Process in Chapter 3, “Account Setup”) but you can enable and 

schedule them at any point in time using the Options and Settings dialog box. 
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To schedule daily automatic backups: 

• On the Attix5 Pro menu, click Preferences. Alternatively, click the Options button on 

the toolbar. 

• In the Options and Settings dialog box, click Backup Schedule. 

• Select the Daily Automatic Backups check box, and then specify a backup time in the 

Back up every day at box. 

• Click OK. 

To schedule advanced backups: 

• On the Attix5 Pro menu, click Preferences. 

• In the Options and Settings dialog box, click Backup Schedule. 

• Select the Advanced Schedule check box. 

• In the Week Day box, select a day on which a backup should be initiated. 

• Specify the time in the Backup time box. 

• Click the Add button to add the day and time to the Additional Schedule box. 

• Repeat steps 5 to 7 above until you have added all desired schedules to the Additional 
Schedule box. 

 

 Tips: 
You are advised to back up at night when the machine running the Backup Client is not 
in use. It must be switched on at the scheduled backup time(s), but the Mac  user does 
not need to be logged in. 
Configuring automatic backups ensures that all selected data is backed up 
automatically, without the need for any user interaction. This is a safer alternative to 
relying on manual backups. 

 

Backups will initiate at the scheduled times and the Backup dialog box will appear displaying 

the progress of the backup: 
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 Tips: 
To close the Backup Client after the backup process has started, click the Hide button.  This 
will not cancel the backup process and you can re-open the Backup Client at any time to view 
the progress of the backup. 
To view backup logs, click the Logs tab. Backup log dates are displayed in blue. 

 
 

Backups will be stored on the Storage Platform and accessible via the Restore tab. For more 

information on restoring data, see Chapter 6, “Restores.” 

Cancelling a backup 

 

Once a backup is in progress, you can cancel the process via the Backup progress window or 

using the system tray icon. 

To cancel a backup: 

In the Backup progress window, click the Cancel button. 

 
The backup will be cancelled.  
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Resuming a backup 
 

By default, the Backup Client tries to connect to the Storage Platform four times before 

cancelling the backup process.  If, however, the previous backup was not successful and a 

manual backup is initiated, the Backup Client will display the prompt: “Do you want to resume 
the failed backup...?” with a 30 second countdown. Click Yes to instruct the Backup Client to 

try to continue from where the process failed during the previous backup. Click No to initiate a 

new backup or Cancel to return to the Backup Client application window.   

 

 Note: A new backup will be initiated automatically after the countdown has elapsed. 
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6 Restores  
On the Restore tab, you can browse a tree structure representation of all successful backups 

and their files and folders. 

How to restore 

The following sections describe how to select data to restore, start the restore process, and 

search for specific backed up files. 

Selecting data to restore 

On the Restore tab, the Restore tree gives you access to backed up files via two main nodes: 

Last Backup and Previous Backups. 

 

The Last Backup node contains the file/folder structure of the last successful backup and 

displays the date and time it occurred in parentheses “( )”.  

 

 Note: Restores done from the Last Backup node are typically faster than those done 
from the Previous Backups node as the Backup Client may be able to retrieve the data 
from the cache instead the Storage Platform. 

 

When you expand the Previous Backups node, the Backup Client retrieves the list of previous 

backups from the Storage Platform and displays them in the tree. 
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To select and restore data from the last backup: 

• Click the Restore tab. 

• Expand the Last Backup node to view the files/folders. 

• Include a single file by clicking the  icon next to the file or by pointing to the file name, 

Control-clicking, and then clicking Include.  Each included file is displayed with a green 

icon: .   

• Include an entire folder by pointing to the folder, Control-clicking, and then clicking 

Include folder.  Each included folder is displayed with a green folder icon: . 

• If an entire folder is included but you wish to exclude a particular file or subfolder, point 

to the file or folder icon, Control-click, and then click Exclude or Exclude Folder. 

Excluded items are displayed with red icons:  or . Included folders that have some 

files or subfolders excluded are green with a red tint: . 

• Once all the files and folders to be restored are selected, start the restore process by 

clicking Restore on the File menu or the Restore button on the toolbar. For information 

on the restore options available, see “Restoring data” later in this chapter. 

To select and restore data from previous backups: 

• Click the Restore tab.  

• Expand the Previous Backups node to connect to the Storage Platform and retrieve a 

list of all previous backup dates. 

• Expand the relevant backup node, and then click the folder/directory containing the 

data. 

• Include a single file by clicking the  icon next to the file or by pointing to the file name, 

Control-clicking, and then clicking Include.  Each included file is displayed with a green 

icon: .   

• Include an entire folder by pointing to the folder, Control-clicking, and then clicking 

Include folder.  Each included folder is displayed with a green folder icon: . 

• If an entire folder is included but you wish to exclude a particular file or subfolder, point 

to the file or folder icon and Control-click, and then click Exclude or Exclude Folder. 

Excluded items are displayed with red icons:  or . Included folders that have some 

files or subfolders excluded are green with a red tint: . 

• Once all the files and folders to be restored are selected, start the restore process by 

clicking Restore on the File menu or the Restore button on the toolbar. For information 

on the restore options available, see “Restoring data” below.  
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Restoring data 

 

After you have selected the files and folders to restore, you can start the restore process as 

described below. 

To start the restore process:  

• On the File menu, click Restore. Alternatively, click the Restore button on the toolbar: 

 
The Restore dialog box will prompt you for a restore location: 

 
• Select Original location to restore the files to the same location that they were backed 

up from or select Folder and then browse to a new location.  

 

 Warning: If Original location is selected, the restored files will overwrite any 
existing files with the same name in that location.  A warning will, however, be 
displayed before the Backup Client overwrites any files. 

 

• In the Options area, specify the restore options.  

•  
• For more information on restore options, see the “Restore options” table below. 

• Click OK.  
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Restore options 

Option Description 

Recreate directory 

structure 

By default, the folder structure is recreated in the Restore folder.  To specify 

that all files be restored to one location, clear the Recreate folder structure 

check box.   

 

 Note: If restoring files from different folders with 

the same file names, you need to recreate the 

folder structure to prevent overwriting the files.   
     

Restore empty folders 

To restore all empty folders within the directory structure, select the Restore 

empty folders check box. Clear the check box to restore only those folders 

containing backed up files.  

 

 Note: This option is only available when 

Recreate directory structure is selected. 
     

Overwrite files 

Select this option to prevent the Backup Client displaying a prompt before 

overwriting existing files. 

 

 Warning: If this check box is selected, files with matching 

filenames in matching directories will be overwritten without 

warning.  
  

Use compression 

Select the Use compression check box to enable the Storage Platform to 

compress files before transmitting them to the Backup Client. 

 

 Tip: You are advised to enable this setting when 

restoring over a slow Internet connection as it 

will reduce the size of the files, making the 

transfer process faster. 
  

 

 Note: You can view restore logs on the Logs tab. Restore log dates are displayed in 
green. 
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Finding files in backups 

To find a specific backed up file, it may be easier to use the Find function than to browse the 

Restore tree. 

 

You have the option to scan only your last backup (locally), or you can connect to the Storage 

Platform and search through previous backups. 

To search for a file in your latest backup:  

• On the File menu, click Find files in backups. Alternatively, click the Find button on 

the toolbar: 

 
• Type the file name or part thereof in the File name box, and then click Find.  

 
 

 Example: If “stats” is searched for, the Backup Client will display a list of all files in the 
last backup containing “stats” in the filename. 

 Tip: Use the * and ? wildcards for advanced search queries. 
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To search for a file in previous backups: 

• On the File menu, click Find files in backups. Alternatively, click the Find button on the 

toolbar: 

 
• Type the file name or part thereof in the File name box.  

• Select the Search through previous backups (Storage Platform) check box. 

• If you wish to limit the search to particular dates, select the Search backup dates 

check box and then use the Start date and End date boxes to specify a time period. 

• To limit the number of results that display, select the Limit number of results to check 

box and then type a number in the box provided. 

• Click Find. 

 Tip: Use the * and ? wildcards for advanced search queries. 
 

 Note: If Search backup dates is selected, the backup date is used for the search 
instead of the file create or file modified date. 
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To restore files from the Find Files in Backup dialog box:  

• In the search results list, include the files to restore by clicking the icons next to the file 

names or by Control-clicking each file name and then clicking Include. 

• Click the Restore button. 

 
The Restore Options dialog box will appear, enabling you to specify the location in which to 

save the restored files. For more information on restore options, see “Selecting data to restore” 

earlier in this chapter. 

Restoring a backup selection 

By default, with every backup performed, a copy of the backup selection is saved on the 

Storage Platform. For more information on backup selection, see “Selecting data to back up” 

earlier in this chapter. 

 

This enables you to restore, not only your backed up files and folders, but the selection you 

used to back them up as well. 

 

 Note: This is especially useful in disaster recovery cases, as it enables you to restore 
your entire backup setup to perform exactly as it did at the last backup. 
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To restore a backup selection: 

• Click the Restore tab. 

• Expand the relevant backup folder, and then click the Workspace node. 

 

• In the right-hand pane, click the icon next to the name of the backup set to include it for 

restore. Include the backupset.xml entry. 

 
• Click the Restore button on the toolbar. 

• Select the appropriate restore options. (See “Selecting data to restore” earlier in this 

chapter.) 

• Click OK. 

 

The backup selection will be restored to the location specified in the restore options.  
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Restoring archived data 

Attix5 Pro allows Backup Administrators to archive Backup Clients’ data to tape or another disk 

drive using the Hierarchical Storage Management (HSM) feature. Once data has been archived, 

the backups will display in the Restore tree as greyed out folders, allowing you to browse the 

file/folder structure of the backups. However, if you try to restore archived data, you may receive 

a message informing you that the data has been archived to secondary storage, as illustrated in 

the screenshot below. 

 

 Note: Grey folders indicate archived data. However, if you do not see these folders in the 
Restore tree, it does not mean that no archived backups are available. In such cases, 
please consult your Backup Administrator for further details about archived backups. 

 

You can access archived data by requesting that your Backup Administrator import the HSM 

data to the Storage Platform. Once the data has been imported, it will be available for restore in 

the same manner as all other backups. 
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7 Logs 
The Backup Client logs all backup and restore processes and their results in log files that you 

can view on the Logs tab. The following sections describe how to access log files and modify 

their settings. 

Accessing log files 

The Logs tab in the Backup Client provides detailed information about each backup and 

restore.  An additional toolbar button appears when the Logs tab is opened: the Summary 

button. Use the button to view only errors and warnings and the last 14 lines in the log file. 

 
 

Changing log file settings 

You can specify your logging preferences on the Logging page in the Options and Settings 

dialog box.  

Modifiable settings include: 

• level of detail included 

• date inclusion/exclusion in time stamp 

• log file retention period 

For information on configuring the log file settings, see Logging in Chapter 8, “Options and 

settings.”  
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8 Options and settings 

To access the Options and Settings dialog box: 

• On the Attix5 Pro menu, click Preferences.  

• Alternatively, click the Options button on the toolbar: 

 
The various options and settings are grouped in the left-hand pane according to their functions. 

Click an item on the left to view the full set of options related to that function. 

 

 Example: Click Advanced Options in the left-hand pane to view all advanced options on 
the right:  

 

 

 Warning: The Options and Settings dialog box controls advanced features in the 
Backup Client. Please read through this section carefully before changing any settings.  
Incorrect settings could cause critical errors. 
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Account and Security 

You can use the Account and Security page in the Options and Settings dialog box to: 

• Update Account information 

• Change your password, encryption key or Backup Account properties 

• Modify Client security settings 
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The Account and Security page consists of the following areas: 

• Account Information area 

• Account Setup area 

• Security Settings area 

 

Account Information area 

This area displays your Backup Account information as it is configured on the Storage Platform. 

You can use the Retrieve Settings button to update your Account settings.  

 

 Tip: This button is useful to verify that the Account limit has been modified after 
requesting a change from the Backup Administrator or to update Backup Group 
Profiling settings. 

 

Account Setup area 

You can use the Change Password and Change Encryption Key buttons to overwrite the 

current password and encryption key. To change your Backup Account settings, click the Run 
Setup Wizard button. For more information, see Account Setup Wizard in Chapter 3, “Account 

setup.” 

 

 Warnings:  
Changing the encryption key involves intensive processing on the Storage Platform and 

may take several minutes.  You should avoid doing this unless the encryption key has 

been compromised. 

Disaster recovery is not possible without the encryption key. Please ensure that this key 

is kept in a safe place. THIS ENCRYPTION KEY IS NOT STORED ON THE STORAGE 

PLATFORM AND CANNOT BE RECOVERED OR RESET IF LOST. 

 

Security Settings area 

In the Security Settings area, you can select whether or not the Backup Client should remember 

the Backup Account password when running a backup or a restore. 
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There are three options available: 

• Remember password for backup and restore: The Backup Client remembers the 

Backup Account password when doing a backup or restore. This is the default setting. 

• Prompt for password on restore: The Backup Client prompts for the Backup Account 

password during the restore process. 

• Prompt for password to open the Backup Client and to restore: The Backup Client 

prompts for the Backup Account password when opening the Backup Client and 

the Restore tab. 

 

Connections 

You can use the Connections page in the Options and Settings dialog box to: 

• Modify Storage Platform connection settings 

• Enable/disable/configure proxy server details 
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The Connections page consists of the following areas: 

 Connection Settings area 

 Proxy Server area 

 

Connection Settings area  

In this area, you can change the type of connection that the Backup Client uses to connect to 

the Storage Platform. You can choose between a network or dial-up connection. 

 

 Note: The Dial-up Settings button is enabled if you select Use dial-up connection. 
Click this button to select an existing dial-up connection configured on the computer and 
then supply the username and password for that Internet connection.  

 
Proxy Server area 

In this area, you can specify whether or not the Backup Client should connect to a proxy server 

when connecting to the Internet. If you select that it should, you can specify the proxy server 

details in the relevant boxes. 
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Backup Schedule 

You can use the Backup Schedule page in the Options and Settings dialog box to: 

• Enable/disable daily automatic backups 

• Create advanced automatic backup schedules 

• Configure Backup Client reactions to skipped backups 

 

 
 



 

 

 

 

Zen Internet, Sandbrook Park, Sandbrook Way, Rochdale OL11 1RY    Registered in England No. 03101568 
Tel: 01706 902000  Fax: 01706 902005  Email: info@zen.co.uk  Web: www.zen.co.uk © Zen Internet 2015 

 

57 

The Backup Schedule page consists of the following areas: 

• Automatic Backups area 

• Skipped Backups area 

 

Automatic Backups area 

In this area, you can enable or disable automatic backups. 

 

 Tip: Daily automatic backups are enabled by default unless disabled during the 
Backup Account setup. If disabled, you can enable it by following the instructions 
below. 

 

To enable automatic backups: 

• Select the Daily automatic backups check box. 

• Specify a time in the Backup every day at box 

• Click Ok. 

To disable automatic backups (not recommended):  

• Clear the Daily automatic backups and Advanced Schedule check boxes. 

• Click Ok to close the Options and Settings dialog box. 

 

 Warning: This option is not recommended. If an automated backup schedule is not 
created, backups will have to be run manually. Enabling automatic backups is strongly 
advised. 

 

For detailed instructions on how to enable and schedule automatic backups, see Scheduling 

automatic backups in Chapter 5, “Backups.” 

Skipped Backups area 

In this area, you can specify what action the Backup Client should take in the event of skipped 

backups.  

 

The following options are available: 

• Do not display a warning 

• Warn after 4 days when online 

• Warn immediately when online 
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Backup Throttle 

The Backup Throttle page in the Options and Settings dialog box enables you to specify the 

Client's bandwidth usage speed limits. You can do this by creating a backup throttle schedule. 

Backed up data will then only be transferred at the specified speed limits during each interval. 
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The Backup Throttle page consists of the following areas: 
• Speed Limits area 

• Throttle Map area 

 

Speed Limits area 

In this area, you can specify one or more speed limits (in kilobytes per second) that can be 

applied when sending backup data to the Storage Platform. 

To specify a speed limit: 

Choose a colour to represent the limit and specify the limit in that colour’s Limit box.  

You can now schedule the speed limits in the Throttle Map area as described below. 

 

 Note: A limit of 0 indicates that no limit will be applied. 
 

Throttle Map area 

In this area, you can indicate when the speed limits specified in the Speed Limits area should 

apply by creating a throttle map.  

 

 Tip: By default, a throttle map is provided with different colours indicating week day 
office hours, out-of-office hours and weekends (using intervals of 60 minutes). You can 
either set speed limits for the colours used in this default map or you can click 
the Clear button and create a new map by following the instructions below. 

 

To create a throttle map: 

• In the Interval box, specify the number of minutes that each block in the graph should 

represent. 

• In the Speed Limits area, click a speed limit colour. 

• In the Throttle Map area, click the schedule interval boxes you wish to apply the limit to. 

The colour of the selected interval boxes will change to match that of the chosen limit. 
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Display 

You can use the Display page in the Options and Settings dialog box to select your Backup 

Client display preferences. 
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The Display page consists of a Selection Table area that provides you with the following 

options: 

• Display File Type column in selection table - Adds a File Type column to the right-

hand pane of the Backup Selection and Restore tabs.  

• Display folders in selection table - Enables the Backup Selection tab’s right-hand 

pane to display subfolders. 

 

Disk Usage 

You can use the Disk Usage page in the Options and Settings dialog box to: 

• Move the working folders and cache to a different location 

• Specify the number of days that files are to be kept in the cache 
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The Disk Usage page consists of the following areas: 

• Working Folders area 

• Cache area 

 

Working Folders area 

If you have limited space on the drive running the Backup Client, you can move 

the Cache, Logs and Temporary folders as well as the selection database to another location. 

 

The following locations are configurable in this area: 

• Temp - Used as temporary workspace when the files are patched, compressed and 

encrypted. 

• Cache - Keeps a local, compressed and encrypted, copy of the selected files for a 

specified number of days. 

• Logs - Stores all backup and restore logs. 

• Database - Compares the latest backup selection with the previous backup to 

determine the changes. 

 Warnings:  
The Cache and Temp folders must reside on the same drive/volume.  

If the database or any of the folders are stored on a network share, please ensure that the 

Backup Service has the correct permissions to connect and write to that share. 

 

Cache area 

When modifications are made to a file, the Backup Client only transmits changes to that file, as 

opposed to transmitting the complete file again. This is accomplished by the use of a local 

cache. 

 

By default, recently modified files are kept in the Cache for 20 days, after which they will be 

deleted. Once a file has been flushed from the cache, a full copy will be backed up when any 

modifications are made to the file. The longer files are kept in the Cache, the better the chance 

of only transmitting patches instead of full copies and thus reducing the amount of data that 

needs to be transmitted. If there is limited disk space available, consider shortening the time 

files are kept in the cache. 
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 Note: If you specify 0 days for caching, patching is disabled. All files in the Cache will be 
deleted, and full copies of changed files will be transmitted to the Storage Platform during 
each backup. 

 

To delete the current cache, use the Clear Cache button. If the cache is deleted, full copies of 

the selected files will be re-sent to the Storage Platform during the next backup.   

 Note: The Backup Client will log the message Doing monthly cache cleanup 
once a month. This maintenance task is to ensure that there are no 
redundant files in the Cache. 

Performance and Limits 

You can use the Performance and Limits page in the Options and Settings dialog box to: 

• Increase/decrease Backup Client processor usage 

• Increase/decrease Backup Client disk access usage 

• Restrict backup size 
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The Performance and Limits page consists of the following areas: 

• Processor Usage & Disk Access area 

• Limits area 

 

Processor Usage & Disk Access area 

The Backup Client uses a fair portion of available processor power to patch, compress and 

encrypt files during the backup process. If you use the computer at the same time, you may 

experience some performance deterioration. To lessen this effect, you can lower the Processor 
Usage.  

 

 Warning: If you use the highest Processor Usage setting, it will affect machine’s 
performance during the backup. 

 
Disk Access is another setting that you can modify to limit performance deterioration.  If you use 

the High setting, the Backup Client will continuously use all available disk access to read and 

write to the disk, ensuring that the process completes as quickly as possible.  The process will 

take longer if this setting is lowered but other disk-intensive applications will perform better. 

 

Limits area 

Select the Restrict size of each backup (MB) check box and specify a maximum value to limit 

the total amount of data that may be transmitted to the Storage Platform during each backup.   

 

 Note: If this option is enabled, it may take several backups before all files are transmitted 
to the Storage Platform. This feature is especially useful when using a slow Internet 
connection and there are problems with transmitting large backups. 

 

Cycle backup process... – You can use this setting in conjunction with the backup size 

restriction to cycle backups successively until all data included in the backup selection has been 

transmitted to the Storage Platform. This setting can only be enabled if a backup size restriction 

has been specified. 



 

 

 

 

Zen Internet, Sandbrook Park, Sandbrook Way, Rochdale OL11 1RY    Registered in England No. 03101568 
Tel: 01706 902000  Fax: 01706 902005  Email: info@zen.co.uk  Web: www.zen.co.uk © Zen Internet 2015 

 

65 

Logging 

You can use the Logging page in the Options and Settings dialog box to specify your logging 

preferences. 

 

Modifiable logging settings include: 

• Level of detail included 

• Date inclusion/exclusion in time stamp 

• Application log location and debug inclusion/exclusion 

• Log file retention period 
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The Logging page in the Options and Settings dialog box consists of the following areas: 

• Backup and Restore Logs  

• Application Log  

• Automatic Log File Deletion  

 

Backup and Restore Logs area 

In this area, you can specify the level of information to be included in the log files by selecting 

one of the options provided:  

• All information (logs all messages) 

• Suppress detail 

• Log warnings and errors (logs only warnings and errors) 

 

Select the Include date in log file time stamp check box to add the date to every line in each 

log file. 
 

Application Log area 

In this area, you can specify where the Backup Client's application log file should be saved and 

whether or not debug messages should be logged. 

 

Automatic Log File Deletion area 

In this area, you can enable a log file retention period by specifying that the Backup Client 

delete files older than a particular number of days. To do this, select the Delete log files older 
than check box, and then specify the number of days in the box provided. 

 

 Tip: To delete all logs older than the specified number of days immediately, click the 
Delete Older Logs Now button. 
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Advanced Options 

You can use the Advanced Options page in the Options and Settings dialog box to configure 

the following Backup Client options: 

• Storage Platform communication 

• Retries and timeouts 
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The Advanced Options page in the Options and Settings dialog box consists of the following 

areas: 

• Communications area 

• Retries and Timeouts area 

 

Communications area 

Always connect to the Storage Platform during the backup process 

When the Always connect to the Storage Platform... check box is selected, the Backup Client 

will connect to the Storage Platform during each backup, whether or not changes were made. 

This updates the Last Backup date stamp, even if there were no changes made to the backup 

set, ensuring that the Storage Platform always reflects the latest backup date.  

 

Use secure (SSL-enabled) connection for data transfer... 

This option is selected by default, enabling SSL encryption for Client-to-StorageServer data 

transfers. Deselecting this option disables SSL encryption for data transfer. This enhances 

transfer speeds but should only be done within a secure network environment.  

 

 Notes: 
Disabling this feature will only have an effect on security for the actual data transfer and 
not the encryption of the data on the Storage Platform. 
Secure data transfer connections can only be disabled if the StorageServer has been 
configured to accept non-secure connections. If the StorageServer cannot accept non-
secure connections, an SSL-enabled connection will automatically be used instead. 

 Warning: If you wish to disable SSL encryption, please ensure that the backup 
environment is secure. 

 

Retries and Timeouts area 

Number of Backup/Restore attempts before cancelling  

By default, the Backup Client tries to connect to the Storage Platform four times before 

cancelling the backup process.  You are advised to increase the number of attempts when using 

a slow Internet connection.  The backup will continue from the previous point of failure and not 

resend the entire backup.  
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Duration between connection retries  

By default, if the connection is dropped, the Backup Client will try to reconnect to the Storage 

Platform after 60 seconds.  This setting enables you to increase/decrease the duration between 

the retries.  

 

Socket timeout 

If the Backup Client is connected to the Storage Platform and there is no communication 

between the two, the time specified in this box (in seconds) is how long the Backup Client will 

stay connected before dropping the connection. The default socket timeout is 60 seconds. 

 

Advanced tools 

DL includes tools that allow advanced users to modify, enhance and streamline the Backup 

Client. 

 

Remote management 

Remote Management enables the Backup Administrator to remotely access and configure the 

Backup Client using the Storage Platform Console.  

To enable Remote Management:  

• On the Tools menu, click Remote Management. 

• In the Remote Management Settings dialog box that appears, select the Enable 
Remote Management check box.  

• In the Connection area, ensure that the port number in the Port box is correct (9091 is 

specified by default). If incorrect, modify as required. 

• If the machine has multiple IP addresses available, you can specify whether the 

Remote Service must bind to all available IP addresses or to only one IP address. 

• In the Access area, select the access credentials to be allowed. 
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 Notes:  
Allow SP controlled access enables Backup Administrators with the correct 
access permissions to use their Storage Platform User Access Management 
usernames and passwords to connect to and administer this Backup Client. If 
you clear this check box, Storage Platform administrators will not have remote 
access. 
Select Allow custom access and supply a username and password if you do 
not wish to make use of the above-mentioned Storage Platform Access 
Accounts. These custom access credentials must be specified in the Storage 
Platform Console for its user to gain remote access. 

• Click OK to save the settings. Services will restart automatically to apply the settings. 

 

Health Check 

The Backup Client Health Check provides information to highlight possible issues before backup 

(e.g. free disk space or file/folder access problems).  It can also provide the estimated line 

speed to the Storage Platform. 

 
The following options are available: 

• Memory - Memory utilisation statistics from the last backup as well as overall memory 

usage to date. 
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• Data Protected - Information includes the number of files and directories included in 

the backup selection. 

• Disk Usage - Free space availability for all local drives. 

• Line Speed - Line Speed estimate to the Storage Platform (determined by transmitting 

data for 10 seconds). 

 

You can specify which checks to run by selecting or clearing the relevant check boxes in the 

Options area. Use the Show Last Health Check button to see the last report. You 

can Print and/or Export the Health Check reports. 

 

To run a health check: 

• On the Tools menu, click Health Check. 

• In the dialog box that appears, specify which checks to run by selecting or clearing the 

check boxes next to the options. Four checks are available (see above). 

• Click the Start button to begin the health check process. The Health Check dialog box 

appears, displaying the progress of the health check until completion. 

 
• When the message: “Health check complete” displays, click OK.  
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The Health Check results display in a new dialog box with options to print, export to HTML and 

export to CSV. 
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Backup Snapshots 

The Backup Snapshot feature enables you to create a backup of all items included in your 

backup selection and send it to a disk drive. This Snapshot data can then be moved to the 

Storage Platform. 

 

You can use this feature to reduce the initial backup window if there is a large amount of data to 

be transferred, typically over a slow Internet/network connection. A similar procedure enables 

you to restore a large amount of data (e.g. during a disaster recovery). 

 

 Note: A snapshot backup uses Blowfish 448 encryption and the backup encryption key to 
encrypt the data. 

 Warnings: 
This procedure should only be performed with the assistance of the Backup 
Administrator.  
Ensure that you have an active Backup Account. 
Before beginning the Backup Snapshot process, it is best to perform a test backup, 
transferring only a small amount of data, to ensure that the StorageServer connection is 
successful.   

 

To export a Backup Snapshot: 

• On the Tools menu, point to Snapshot, and then click Export Backup Snapshot. 

• Select The next backup must be a Snapshot backup. 

• Specify a destination in the box provided. 

• Click OK. 

• Initiate a backup. 

 

The Snapshot data is now stored in the location specified in step 3 above and can be moved to 

the Storage Platform. The Backup Administrator can then import the snapshot data to the 

StorageServer using the Storage Platform Console. (For more information, please refer to the 

Storage Platform Console User Manual.) 

 

 Note: The Backup Account will be disabled at this point to ensure that the Snapshot data 
is the most recent. Once the data has been successfully imported to the Storage 
Platform, the Account will be enabled automatically and backups can proceed as usual. 
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Restore Snapshots (Disaster recovery) 

The Restore Snapshot feature enables you to restore large amounts of data from a locally 

connected device to a machine via the Backup Client. 

 

 Notes:  
Before you can perform the steps outlined below, the snapshot data needs to be 
exported from the StorageServer to a mobile storage device by a Backup 
Administrator. For more information, please refer to the Storage Platform Console 
User Manual. 
A snapshot restore uses Blowfish 448 encryption and the backup encryption key to 
encrypt the data. 

 

To restore data from a Snapshot: 

• Connect the mobile storage device containing the snapshot data to the Client machine 

or to a Local Area Network so that it has access to the Client machine. 

• On the Tools menu, point to Snapshot, and then click Import Restore Snapshot. 

• Select whether you wish to restore the data from a disk drive or recovery server. 

a. If restoring from disk, select the Show Restore Snapshot(s) in Restore 
panel check box and then specify the path to the data in the Snapshot 
location box. 

 Warning: The default snapshot location specified is: 
\Backups\Import\Snapshot-Restore. If you wish to use this location, you 
need to create the folder structure on the machine and then paste the 
snapshot data onto the Snapshot-Restore folder. This folder is not created 
automatically. Alternatively, you can use the Browse button to browse to 
the location in which you have saved the snapshot data. 

 Note: You need to specify the snapshot data’s parent folder, NOT the 
snapshot folder itself. (E.g. If your snapshot data folder is called 
20100506124347 and you’ve copied it to \Backups\Import\Snapshot-
Restore, you need to specify \Backups\Import\Snapshot-Restore in the 
Snapshot location box, NOT \Backups\Import\Snapshot-Restore 
20100506124347.) 

b. If restoring from a recovery server, select the Do restores from recovery 
server check box and then specify the server address and port number in the 

boxes provided. If using a proxy server, select the Use proxy settings for 
recovery check box. 

 Note: This option can only be used if the Backup Administrator has 
prepared a recovery server. 

• Click OK. 
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The Snapshot data will display as an entry in the Restore tree, enabling you to browse a 

directory of its contents and restore files and folders. For more information, see Chapter 6, 

“Restores.” 

 

Profiling 

Profiling enables your Backup Administrator to propagate certain client-side settings from the 

Storage Platform to your Backup Client. 

 

It can be used to enforce the following settings: 

• Backup schedules 

• Inclusions and exclusions 

• Filters 

• Most options and settings accessible via the Tools and Attix5 Pro menus 

 

 Note: Profiled settings take priority over settings specified in the Backup Client. 
When the Backup Client connects to the Storage Platform, it receives a list of all profiled 
settings. These changes are implemented in the Backup Client. You can, however, 
connect to the Storage Platform and update profiled settings manually. 

To update profiled settings manually: 

• On the Attix5 Pro menu, click Preferences. 

• On the Account and Security page of the Options and Settings dialog box, click 

the Retrieve Settings button. 

 

The Backup Client will retrieve any profiled settings from the Storage Platform and update its 

options and settings accordingly. 

 

 Note: Profiled settings are greyed out, and cannot be modified from within the Backup 
Client. 
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Inclusions /exclusions applied by profiling are displayed with yellow icons in the Backup Client:  

 

File icons: 

   Included file 

   File included by filter 

   Excluded file 

 

Folder icons: 

   Included folder 

   Folder included by filter 

   Excluded folder 

 

 

  



 

 

 

 

Zen Internet, Sandbrook Park, Sandbrook Way, Rochdale OL11 1RY    Registered in England No. 03101568 
Tel: 01706 902000  Fax: 01706 902005  Email: info@zen.co.uk  Web: www.zen.co.uk © Zen Internet 2015 

 

77 

9 Reference 
 

Keyboard shortcuts and hotkeys 

  

Keys Action 

F5 Refresh active window 

SPACEBAR x1 Include selected file/folder 

SPACEBAR x2 Exclude selected file/folder 

SPACEBAR x3 Clear inclusion/exclusion 

SHIFT+/ Select multiple files 
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